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1. Tvorba nové databáze 
 
1. V programu Turboveg zvolte Database/New. 
 

 
 
 
2. V dialogovém okně vyplňte povinně jméno (Database name), rozsah čísel přidělený 

lokálním koordinátorem (pokud vám byl předělen – Range for  relevé numbers), 
zaškrtněte Extended u struktury (Structure header database); nepovinně můžete 
vyplnit název složky (Folder). 
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Technická poznámka k políčku FOLDER: Pokud toto pole nevyplníte, pak se všechny založené databáze 
ukládají jako vlastní složka v adresáři Turbowin/data/JmenoDB, která obsahuje soubory tvhabita.dbf 
(hlavičky snímků), tvabund.dbf (druhové složení snímků) a tvremarks.dbf (pole poznámky delší než 50 
znaků) s příslušnými indexy. Při otevírání DB lze vidět všechny již založené DB. Je to vhodné pro uživatele, 
kteří mají malé množství databázových souborů a nesdílejí počítač s více lidmi. Pokud vyplníme pole 
Folder, pak se vytváří složitější adresářová struktura. DB se ukládá jako složka v adresáři 
Turbowin/data/Jmenofolderu/JmenoDB s výše zmiňovanými soubory. Tato struktura je vhodná, pokud 
jeden počítač používá více uživatelů, z nichž si každý udržuje vlastní DB nebo když jeden člověk udržuje 
větší množství různých databázových souborů. 
 
Př. DB s adresářovou strukturou: 
 

 

Adresáře 
(folder) 

Databáze 

3. V nových databázích nejprve modifikujte strukturu polí přes Dababase => Modify 
structure: 
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Pak vložte následující pole:  

Název pole TYP POLE Délka pole Počet 
desetinných 
míst 

LOCALITY C 99 0 
LONGITUDE N 9 2 
LATITUDE N 9 2 
BIAS_MIN N 2 0 
BIAS_GPS N 3 0 
CEBA_GRID C 6 0 
FIELD_NR C 10 0 
HABITAT C 99 0 
GEOLOGY C 50 0 
SOIL C 50 0 
WATER_PH N 5 2 
S_PH_H2O N 5 2 
S_PH_KCL N 5 2 
S_PH_CACL2 N 5 2 
SOIL_PH N 5 2 
CONDUCT N 7 1 

 
Poznámka: U pole „S_PH_H2O“ je v písmeno „O“, nikoli číslice „0“. 
 

Postup vložení prvního pole: vyplnit jméno, typ pole, délku a počet desetinných 
míst; odkliknout Add; Stejným způsobem druhé pole a každé další. Pokud uděláte chybu, 
nevadí – pole lze upravit pomocí funkce Edit, mazat pomocí funkce Delete. Předtím než 
dialogové okno zavřete, musíte uložit změny pomocí funkce Rebuild. 

Pro usnadnění byla vytvořena databáze s názvem „Vzor“, která obsahuje všechna 
povinná pole. Tuto databázi si můžete stáhnout na 
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http://www.sci.muni.cz/botany/vegsci/dbase/vzor.zip a do TURBOVEGu ji nahrát 
následujícím způsobem: 
TURBOVEG:  
1) Obsah souboru Vzor.zip rozbalte do složky C:\turbowin\data 
2) Změňte název složky „Vzor“ podle potřeby – nejlépe bez diakritiky (např. 

C:\turbowin\data\Vzor na C:\turbowin\data\vasejmeno) Tím máte nachystanou 
databázi, do které můžete začít psát. 

Výše uvedená pole jsou povinná a musí být vložena do každé databáze. Mimo 
výše uvedený soupis si můžete definovat svoje specifická pole, např. plodina (u snímků 
plevelové vegetace) apod. Tato pole ale pokud možno umístěte až za všechna povinná 
pole (tj. za pole CONDUCT). 
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2a. Zadávání dat – jednotlivé snímky 
 
A. Nový snímek lze vložit několika způsoby: a) přes Edit/Add a relevé b) klávesou Insert 

c) ikonou. 
 

 

Ikona 

 
B. Dialogové okno New relevé (hlavička fytocenologického snímku) se skládá ze dvou 

formulářů – Form 1 a Form 2: 
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Pole se žlutým otazníkem je propojeno s databázemi uloženými v adresáři 
Turbowin/popup/. Lze je tedy vyplnit přímo, nebo pokud kliknete na otazník, můžete 
vybírat ze seznamu (příklad výběru biblioreference).  
 

 
 
 
U některých polí existuje v seznamu funkce Search (např. syntaxon code nebo author 
code), tzn. že píšete např. jméno autora, kterého tímto způsobem nalistujete. 
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Funkce Search 
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C. Po vyplnění hlavičky a kliknutí na Save se objeví dialogové okno, ve kterém zadejte druhy 
vyskytující se ve snímku, pokryvnosti a patro. 

 

 

Zadávání druhů: 

1. Vyhledání názvu – Poté, co se objeví dialogové okno, pište první tři písmena 
z rodového jména a první tři písmena druhového epiteta (př. Quepet pro Quercus 
petraea). V okně Species list se objeví všechny druhy, které přicházejí v úvahu. Pokud 
je jich více, označte daný druh pomocí myši nebo šipek. Druh zvolte pomocí klávesy 
Enter nebo dvojklikem myší. 

2. Výběr patra (layer) – vyberte příslušné patro. 

Poznámky k patrovitosti vegetace: Druhy stromového patra nerozlišeného na podpatra se řadí do Tree 
layer high. Pokud rozlišujete nižší a vyšší stromové patro, pak druhy vyššího zapisujete do Tree layer high 
a nižšího do Tree layer low (patro Tree layer middle používat zřídka, opravdu pouze v případě silně 
vyvinuté patrovitosti porostu). Všechny keře přesahující vzrůstem bylinné patro a stromy do 1,5 m výšky se 
řadí do Shrub layer high (Shrub layer middle se skoro nepoužívá). Do bylinného patra (herb layer) se řadí 
všechny byliny a také řasy. Semenáčky dřevin a velké keře, které dosahují výšky bylinného patra se řadí do 
tzv. Juvenile. Mechy a lišejníky se píší společně do Moss layer.  

3. Zápis pokryvnosti (cover) – jako poslední zvolte pokryvnost a to ve stupni (již 
v hlavičce) zvolené stupnice. Druh přidejte pomocí tlačítka Add. 

4. Úpravy a mazání druhů – pomocí funkce Remove lze mazat již vybrané druhy a 
pomocí funkce Modify lze měnit jméno, patro nebo pokryvnost. 

5. Uložení – pomocí tlačítka Save. 

Malé technické detaily: V dialogovém okně se můžete pohybovat pomocí myši nebo vše ovládat klávesnicí 
(mnohem rychlejší): druh zvolte pomocí šipek a stiskněte klávesu Enter, patro pomocí čísel 1–9, Enter, 
zapište hodnotu pokryvnosti a po dvojím zmáčknutí klávesy Enter se druh zapíše do pravého okénka 
Selected species. 
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2b. Zadávání dat – tabulky 

 
A. Tabulku lze vložit dvěma způsoby: a) přes Edit => Add a table b) pomocí ikony 
 

 

Ikona 

 
B. V dialogovém okně Add table zadejte počet snímků v tabulce, stupnici pokryvnosti a 

můžete zatrhnout Sort table according to species names (většinou nezatrhujte, protože 
je praktické nechat druhy tak, jak je máte v tabulce). Klikněte na Create. 

 

 
 
 



 
 
 
C. Seznamu druhů – v dalším kroku zadejte jména druhů a patra bez pokryvností.  
 

 
 
D. Pokryvnosti druhů – po odkliknutí Save, se otevře tabulka, do které zadejte 

pokryvnosti. Pokud se druh nevyskytuje, políčko nechte nevyplněné. 
 

 
 
E. Hlavičky snímků. Po vyplnění pokryvností jednotlivých druhů a uložení tabulky 

funkcí Save se uloží snímky s prázdnými hlavičkami, které je potřeba doplnit. 
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Pozn. Jakmile máte hotovou tabulku s druhy, patry a pokryvnostmi, tak při stisku tlačítka „Close“ se 
tabulka zavře, ale po opětovném otevření ji lze editovat. Naopak, stisk tlačítka „Save“ tabulku 
definitivně uloží bez možnosti pozdější editace. 
 

4. Vzájemná výměna dat 
 
DBF soubory jsou poměrně velké, a proto v Turbovegu existuje funkce Backup/Restore. 
Funkce Backup sbalí databázi do souboru: jmenodatabaze.zip. Pokud chcete z takto 
sbalených souborů opět vytvořit databázi, použijte Database => Backup/Restore => 
Restore. Snímky do České národní fytocenologické databáze prosím posílejte v tomto 
formátu. 
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4. Návod k vyplnění jednotlivých polí 
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A. Editace informací o druzích 
 
Obecné připomínky: 
 

• Kontrola pater:  
Doporučuji po skončení přepisování snímků ještě zkontrolovat, zda jste rostliny 
zařadili do správného patra.  
Lze to udělat pomocí aplikace TURBOVEG  CHECK-UP (viz. str. 27), nebo pomocí  
programu JUICE (http://www.sci.muni.cz/botany/juice). 
Návod na kontrolu v JUICE: TURBOVEG => otevřít požadovanou databázi => Select 
=> Select all relevés in current database => deselect x relevés => ano => Export => 
Other formats… =>JUICE input files => Include header data (stačí Relevé number), 
JUICE => File => Import => Table => From TURBOVEG or Cornell Condensed File 
=> Species => Mark Layers => Continue => druhy seřadit podle barev (tím seskupíme 
všechny druhy, které jsou v jednom patře) => zkontrolovat, jestli ve skupině (jedné 
barvě) není druh, který do tohoto patra nepatří (častou chybou bývá strom v bylinném 
patře. Ten se píše jako juv.). 

• Hromadná oprava druhů/pater: Na hromadnou opravu druhu nebo patra použijte 
následující postup: TURBOVEG => Edit => Replace species. Zadáte starý druh/patro 
a nahradíte jej novým (viz obrázek). 
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• Pište v češtině: Do všech polí pište informace v češtině. Týká se to polí Remarks, 

Locality, Habitat, Geology a Soil. 
 

A2) 
• Juvenilní patro (juv.): Juvenilní patro (7-Juvenile (jl)) pište u všech dřevin, které se 

nacházejí v bylinném patře a naopak je nepište u bylin – ty pište vždy do bylinného 
patra (6-Herb layer (hl)). Seznam druhů, a pater, ve kterých se běžně vyskytují, 
najdete na http://www.sci.muni.cz/botany/vegsci/dbase/druh-patro.xls. 

• Mechové patro (9-Moss layer (ml)): Do tohoto patra pište všechny mechy, lišejníky a 
řasy. Výjimkou jsou parožnatky: Chara, Nitella a Tolypella – ty se píší do bylinného 
patra. Druhy Riccia a Ricciocarpos mohou být v bylinném i mechovém patře. Seznam 
druhů, které by měly být v České národní fytocenologické databázi v mechovém patře 
najdete na (http://www.sci.muni.cz/botany/vegsci/dbase/druh-patro.xls). 

• Vodní rostliny: Všechny vodní cévnaté rostliny (submerzní, natantní i emerzní 
makrofyty) pište do bylinného patra (6-Herb layer (hl)). 

A3) 
• Rozsahy pokryvností: Pokud jsou pokryvnosti uvedeny jako rozsahy (např. 3–4, r–

+), pište menší hodnotu a do poznámky napište rozsah celý. Např. u druhu Eleocharis 
palustris je uvedeno 1–2. Jako pokryvnost tedy napište 1 a do poznámky dejte 
„Eleocharis palustris 1–2“. 
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B. Editace hlavičkových dat snímků 
 
Obecné připomínky: 
 

 
• Editace jednotlivých polí: Pomocí tlačítka Form edit, které se nachází vpravo dole na 

nástrojové liště, přepnete tabulku s hlavičkovými daty do módu, ve kterém lze editovat 
jednotlivá pole. Díky tomu nemusíte pokaždé otevírat formulář pro vyplňovaní 
hlavičkových dat.  

 

 
 

• Označování/odznačování snímků: Snímky lze rychle označovat/odznačovat pomocí 
mezerníku. 

• Kontrola hlavičkových dat: Kontrolujte prosím po sobě ještě jednou hlavičková 
data. Lze k tomu použít aplikaci TURBOVEG CHECK-UP (viz. str. 27) nebo filtry 
v Excelu.  
Návod na kontrolu v Excelu: TURBOVEG => otevřít požadovanou databázi => Select 
=> Select all relevés in current database => Deselect x relevés => ano => Export => 
MS ACCESS database => vybrat cílový adresář => Export, ACCESS: otevřít tabulku 
headerdata => vše označit (Ctrl+A) => kopírovat (Ctrl+C), EXCEL: otevřít nový => 
vložit data ze schránky (Ctrl+V) => kliknout na 1. řádek => Data => Filtr => 
Automatický filtr => pak klikat na jednotlivé černé šipky – tím se zobrazí souhrn dat, 
která jsou v daném sloupci. Dají se tím rychle najít „divné“ hodnoty, případně prázdná 
pole. 

• Chybějící údaje: Pokud nejsou údaje známé, pak do pole vepište „-1“. Týká se to polí 
vyznačených na následujícím obrázku. Problém TURBOVEGu je, že pole jako např. 
Cover tree (%) jsou automaticky vyplněna nulou. Pak ale nelze poznat, jestli tam 
stromové patro opravdu chybělo, nebo jestli tam stromy byly, ale autor jen 
nevyplňoval pokryvnost. Pokud víte, že tam stromové patro bylo, ale pokryvnost není 
udána, vepište „-1“. Pokud je to ale např. louka, kde stromové patro určitě nebylo, tak 
v poli pokryvnost stromového patra nechte 0. Do pole Aspect (degrees) nejde vyplnit 
„-1“; pokud orientaci svahu neznáte, nevyplňujte nic.  

 

 17



 
 

• Aktualizace popup a species souborů: Pravidelně si aktualizujte popup a species 
soubory. Soubor species.zip uložte do složky C:\Program 
files\turbowin\species\C_europe\ a soubor popup.zip do složky C:\Program 
files\turbowin\popup, soubory rozbalte a při rozbalování nechte přepsat všechno, co je 
už na disku. Tím získáte i aktuální verze seznamu druhů, naší fytocenologické 
bibliografie a seznamu autorů. Ty si můžete odtud po čase zase stáhnout, budeme je 
průběžně aktualizovat. 

 
Popup: http://www.sci.muni.cz/botany/vegsci/dbase/popup.zip
Species: http://www.sci.muni.cz/botany/vegsci/dbase/species.zip
 
Nejaktuálnější verzí druhového seznamu je Czechia_Slovakia_2010. Do tohoto 
seznamu byly přidány některé nově popsané druhy a kříženci. Všechny ostatní druhy 
(jejich kódy) zůstaly nezměněny, takže tento seznam je zcela kompatibilní se snímky, 
které byly zapisovány pod starým seznamem C_europe. Při aktualizaci souboru 
Species postupujete následovně: 
Smažte starý seznam druhů C_europe (složku C:\Program 
files\turbowin\species\C_europe\). Zazipovaný soubor Species rozbalte do složky 
C:\Program files\turbowin\species\. Při prvním pokusu otevřít databázi se objeví 
chybová hláška, která vás informuje o tom, že program nemůže nalézt seznam druhů 
C_europe, který jste právě smazali. Chybovou hlášku potvrďte tlačítkem OK, zcela 
zavřete TURBOVEG a znovu jej otevřete. Při druhém otevření by vám měl program 
nabídnout možnost připojit vaši databázi se snímky k novému druhovému seznamu 
Czechia_Slovakia_2010. Připojení k novému seznamu potvrďte. Toto je bohužel 
potřeba udělat vzlášť pro všechny databáze, které máte v TURBOVEGu uloženy. 
Pokud jich máte větší množství, tak doporučuji, abyste nejprve otevřeli každou 
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databázi vzlášť, odklikli chybové hlášení a teprve pak program ukončili. Při 
opětovném otevření máte možnost jednotlivé databáze postupně připojit k novému 
seznamu druhů. 
Pokud budete mít nadále potíže, zkuste si nainstalovat a aktualizovat zcela nový 
TURBOVEG, který již v sobě má nový seznam druhů zabudovaný. Pro získání 
přístupových práv k instalaci programu kontaktujete správce (danmich@sci.muni.cz).  
 

 
B1) Cover abundance scale 

• Co vyplnit? Zadejte stupnici pokryvnosti, kterou vyberete ze seznamu. 
• Musí se vyplnit? Ano. Toto pole je povinné. 
 

B2) Country code 
• Co vyplnit? Ze seznamu vyberte stát, ze kterého snímek pochází. 
• Musí se vyplnit? Ano. Toto pole je povinné. 
 

B3) Biblioreference 
• Co vyplnit? Ze seznamu vyberte kód biblioreference, který odkazuje na příslušnou 

publikaci. 
• Musí se vyplnit? Toto pole je povinné pokud víte, že snímky byly někde publikovány 

(Platí to i pro inventarizační průzkumy a diplomové práce). 
• Biblioreference v seznamu chybí: Pokud zde nějakou citaci nenaleznete, stáhněte si 

aktuální verzi databází popup.exe  
(http://www.sci.muni.cz/botany/vegsci/dbase/popup.zip). 
V případě, že ji nenaleznete ani zde, kontaktujte správce České národní 
fytocenologické databáze (danmich@sci.muni.cz). 

 
 
B4–B5) No. table in publ., No. relevé in table 

• Co vyplnit? Pokud budete přepisovat snímek, který není v tabulce, tak do pole No. 
table in publ. napište číslo strany ve formátu p.“číslo“ a to bez mezer (např. p.38). p = 
strana (pagina, page). V případě, že je snímků na straně víc, tak do pole No. relevé in 
table napište buď přímo číslo snímku (pokud tam je), nebo číslo označující pořadí 
snímku na straně. Příklady:  
1) V článku je na straně 38 snímek označený jako snímek č. 3. Řešení: No. table in 

publ.: p.38, No. relevé in table: 3.  
2) V článku je na straně číslo 38 pět snímků bez čísla. Vy máte označit poslední 

z nich, tedy pátý. Řešení: No. table in publ.: p.38, No. relevé in table: 5.  
• Musí se vyplnit? Toto pole je povinné pokud víte, že snímky byly někde 

publikovány. Platí to i pro inventarizační průzkumy a diplomové práce. Číslování je 
důležité, protože je občas potřeba snímky dohledávat v originální literatuře. 

 
B6) Project code 

• Co vyplnit? Zadejte kód vašeho projektu.  
• Musí se vyplnit? Ne. Toto pole můžete vyplnit pro vlastní potřebu, pro Českou 

národní fytocenologickou databázi však není nutné a nijak se nevyužívá. 
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B7) Author code 
• Co vyplnit? Ze seznamu vyberte kód autora.  
• Musí se vyplnit? Ano. Toto pole je povinné. 
• Jména autorů s diakritikou: Při vyhledávání jmen autorů si dejte pozor na jména 

s diakritikou (č, ř, ž, á, ú, é atd.), která jsou zařazena až na konec abecedy za písmeno 
Z. Podobně mohou být řazena písmena s diakritikou uvnitř slova. Např. jméno Peřina 
je až za jménem Petřík.  

• Autor v seznamu chybí: Pokud autor v seznamu chybí, stáhněte si nejprve aktuální 
popup (http://www.sci.muni.cz/botany/vegsci/dbase/popup.zip). Pokud jej ani tam 
nenajdete, pak kontaktujte správce České národní fytocenologické databáze 
(danmich@sci.muni.cz).  

 
B8) Date 

• Co vyplnit? Zadejte datum ve formátu rok/měsíc/den (např. 2009/06/01). 
• Musí se vyplnit? Ano. Toto pole je povinné. 
• Neúplné datum: V případě, že neznáte celé datum, je možné doplnit pouze rok a 

měsíc (2009/06/01), případně jen rok (2009/ / ). 
• Dvojí datum u jednoho snímku: Někdy je snímek zapsán na jaře i v létě, aby se 

zachytily druhy jarního i letní aspektu. Do pole Date (year/month/day) napište to 
datum, které odpovídá optimální fenofázi daného vegetačního typu, a druhé pak do 
poznámky.  
Př. Snímek byl snímkován 26.5.1984 a 18.8.1984. Do pole Date (year/month/day)  
napište 1984/05/26 a do poznámky pak „Datum: 1984/05/26 a 1984/08/18“. 

 
B9) Syntaxon 

• Co vyplnit? Ze seznamu vyberte kód syntaxonu. 
• Musí se vyplnit? Syntaxon vybírejte ze seznamu. Toto pole prosím vyplňujte pokud 

možno vždy. Pokud nevíte konkrétní asociaci, tak snímek zařaďte alespoň do svazu, 
řádu nebo třídy. Tato informace je velmi důležitá, protože se z České národní 
fytocenologické databáze dělají často výběry snímků právě na základě syntaxonů. 

• Podle čeho je vytvořen seznam syntaxonů? Seznam syntaxonů je vytvořen podle 
následující publikace: Moravec J., Balátová-Tuláčková E., Blažková D., Hadač E., 
Hejný S., Husák Š., Jeník J., Kolbek J., Krahulec F., Kropáč Z., Neuhäusl R., 
Rybníček K., Řehořek V. & Vicherek J. (1995): Rostlinná společenstva České 
republiky a jejich ohrožení. Ed. 2. Severočeskou Přír., Příl. 1995: 1–206.). 

• Syntaxon není v seznamu: Pokud syntaxon nenajdete v seznamu, napište jej do 
poznámky a do pole Syntaxon vložte kód nadřazeného syntaxonu.  

 
B10) Relevé area 

• Co vyplnit? Zadejte velikost plochy snímku v m2. Pokud ji neznáte, vyplňte „-1“. 
• Musí se vyplnit? Ano. Toto pole je povinné.  

 
B11) UTM grid systém code 

• Co vyplnit? Zadejte lokalizaci v systému UTM. 
• Musí se vyplnit? Toto pole se běžně nevyplňuje. Je povinné pouze v případě, že ke 

snímku nejsou známy zeměpisné souřadnice longitude a latitude, ale je k dispozici 
lokalizace v systému UTM. 
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B12) Altitude 
• Co vyplnit? Zadejte nadmořskou výšku v m n. m. Pokud nadmořskou výšku neznáte, 

vyplňte „-1“. 
• Musí se vyplnit? Ano. Toto pole je povinné.  

 
B13) Aspect 

• Co vyplnit? Orientaci svahu ve stupních od 1 do 360. 
• Musí se vyplnit? Ne. Toto pole je nepovinné. 
• Sever: Sever odpovídá v TURBOVEGu hodnotě 360, nikoli 0. 

 

 
 

• Rovina: Pokud jsou snímky na rovině, pak do pole Aspect (degrees) nevyplňujte nic 
(nepište 0, 000 ani -) a do pole Slope (degrees) zadejte „0“. 

 
B14) Slope 

• Co vyplnit? Vyplňte sklon plochy ve stupních. 
• Musí se vyplnit? Ano. Toto pole je povinné. Pokud sklon svahu neznáte, vyplňte „-

1“. 
• Rovina: Pokud byl snímek zaznamenán na rovině, napište do pole Slope (degrees) „0“ 

a do pole Aspect (degrees) nevyplňujte nic.  
 
B15) Cover total 

• Co vyplnit? Zadejte celkovou pokryvnost všech pater. 
• Musí se vyplnit? Ano. Toto pole je povinné. Pokud celkovou pokryvnost neznáte, 

vyplňte „-1“. 
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• Jak se zjišťuje? Pokryvnost odhadujeme tak, že se na vegetaci díváme shora a 
odhadujeme kolik % plochy snímku zabírají všechna patra. 

• Ve snímku jsou jen druhy z jednoho patra: Pokud máte ve snímku jen druhy 
z jednoho patra (zpravidla bylinného), pokryvnost pište k bylinnému patru. 

 
 
B14) Cover tree layer 

• Co vyplnit? Vyplňte pokryvnost stromového patra v procentech.  
• Musí se vyplnit? Ano. Toto pole je povinné. 

Toto pole vyplňujte v případě, že ve snímku stromy jsou a vy jste jejich pokryvnost 
určovali. Pokud zde stromy jsou, ale vy jste jejich pokryvnost neurčovali, vyplňte „-
1“. Pokud ve snímku stromy nejsou, nechte pole prázdné. 

 
B17) Cover shrub layer 

• Co vyplnit? Vyplňte pokryvnost keřového patra v procentech. 
• Musí se vyplnit? Ano. Toto pole je povinné. 

Toto pole vyplňujte v případě, že ve snímku keře jsou a vy jste jejich pokryvnost 
určovali. Pokud zde keře jsou, ale vy jste jejich pokryvnost neurčovali vyplňte „-1“. 
Pokud ve snímku keře nejsou, nechte pole prázdné. 

 
B18) Cover herb layer 

• Co vyplnit? Vyplňte pokryvnost bylinného patra v procentech. 
• Musí se vyplnit? Ano. Toto pole je povinné. 

Toto pole vyplňujte v případě, že ve snímku byliny jsou a vy jste jejich pokryvnost 
určovali. Pokud zde byliny jsou, ale vy jste jejich pokryvnost neurčovali, vyplňte „-1“. 
Pokud ve snímku byliny nejsou, nechte pole prázdné. 

 
B19) Cover moss layer 

• Co vyplnit? Vyplňte pokryvnost mechového patra v procentech (zde se píší 
mechorosty i lišejníky). 

• Musí se vyplnit? Ano. Toto pole je povinné. Standardně odpovídá patru E0 ve 
fytocenologických snímcích a píší se do něj mechorosty i lišejníky. Toto pole vyplňte 
v případě, že ve snímku mechorosty nebo lišejníky jsou a vy jste jejich pokryvnost 
určovali. Pokud zde mechorosty nebo lišejníky jsou, ale vy jste jejich pokryvnost 
neurčovali, vyplňte „-1“. Pokud ve snímku mechorosty ani lišejníky nejsou, nechte 
pole prázdné. 

 
B20-24) Cover lichen, algae, litter, open water a bare rock 

• Musí se vyplnit? Ne. Tato pole se standardně nevyplňují. 
 

 
B25-30) Height (high) tree , low tree , (high) shrub layer, low shrub, (height) herb, low 

herb layer 
• Co vyplnit? Zadávejte výšku jednotlivých pater. Patro stromové, pokud není rozlišené 

na nižší a vyšší, udáváme do High tree layer, keřové (nerozlišené na nižší a vyšší) do 
High shrub layer a bylinné (nerozlišené na nižší a vyšší) do High herb layer. 

• Musí se vyplnit? Ne. Tato pole jsou nepovinná. 
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B31) Max. height herb layer 
• Co vyplnit? Vyplňte maximální výšku bylinného patra a to v případě, že většina 

porostu má určitou výšku a nějaký druh ji výrazně přesahuje, např. bylinné patro lesů 
může mít často výšku kolem 30 cm, ale na ploše snímku je i pár kapradin 60 cm. Pak 
30 cm uveďte do Height (high herb layer) a 60 cm do Max. height herb layer.  

• Musí se vyplnit? Ne. Toto pole je nepovinné. 
 
B32) Max. height crypt. layer 

• Musí se vyplnit? Ne. Toto pole nevyplňujte. 
 
B33) Mosses identified 

• Co vyplnit? Vyplňte informaci (Y/N) o tom, zda jste určovali, či neurčovali 
mechorosty.  

• Musí se vyplnit? Ano. Toto pole je povinné. Je velmi důležité jej vyplnit, protože 
snímky s hodnotou Y v poli cover mosses mají při výběru často přednost před snímky 
s hodnotou N, nebo před snímky, které toto pole nemají vyplněno vůbec. 

• Kdy se vyplní Y: V případě, že a) ve snímku mechorosty byly a vy jste je všechny 
určili. b) Ve snímku žádné mechorosty nebyly (jednalo se o biotop, ve kterém se 
běžně nevyskytují). 

• Kdy se vyplní N: a) V případě, že ve snímku mechorosty byly, ale vy jste je neurčili, 
nebo jich určili pouze část.  

 
B34) Lichens identified 

• Co vyplnit? Vyplňte informaci (Y/N) o tom, zda jste určovali, či neurčovali lišejníky.  
• Musí se vyplnit? Ano. Toto pole je povinné.  
• Kdy se vyplní Y: V případě, že a) ve snímku lišejníky byly a vy jste je všechny určili. 

b) Ve snímku žádné lišejníky nebyly (jednalo se o biotop, ve kterém se běžně 
nevyskytují). 

• Kdy se vyplní N: a) V případě, že ve snímku lišejníky byly, ale vy jste je neurčili, 
nebo jich určili pouze část.  

 
B35) Coordinate system 

• Co vyplnit? Ze seznamu vybrat kód, který odkazuje na způsob odečítání souřadnic. 
Pozn. Přesnost lokalizace fytocenologických snímků závisí nejen na kvalitě popisu lokality a měřítku 
mapy, ale i na typu mapy (použitém referenčním elipsoidu a zobrazovací ploše), ze které souřadnice 
odečítáme. Totéž místo zemského povrchu se na jiný elipsoid promítne trochu jinam a má proto trochu 
jiné zeměpisné souřadnice. Souřadnice odečtené na naší vojenské mapě TM25 (Krasovského elipsoid) 
se liší od souřadnic získaných z GPS (elipsoid WGS-84) a od souřadnic odečtených na základních 
mapách (Besselův elipsoid). Proto v popup listech přibylo povinné pole COORDINATE SYSTEM, ve 
kterém stanovujete podle jakého zdroje jsou odečteny souřadnice  

• Musí se vyplnit? Ano. Toto pole je povinné.  
Nevyplňujte je pouze v případě, že nevíte, jakým způsobem byly souřadnice získány 
(např. pokud snímky přepisujete z literatury, kde jsou souřadnice přímo uvedeny). 

 
B36) Locality 

• Co vyplnit? Zadejte lokalitu snímku.  
• Musí se vyplnit? Ano. Toto pole je povinné.  
• Formát lokality: Lokality v textové formě by měly být uváděny tak, aby na prvním 

místě bylo jméno obce, následované bližším určením lokality. Vzhledem k 
současnému udávání zeměpisných souřadnic by neměla hrozit záměna mezi dvěma 
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obcemi stejného jména. Zvláště u obcí, jejichž jména se v ČR opakují, však je vhodné 
udat i bližší lokalizaci (např. orografický celek, politický okres apod.) v závorce za 
jménem obce. Příklady: 

1) Stojice (Železné hory), Svinčanský les 1 km SSV obce.  
2) Lukov (NP Podyjí), svah nad levým břehem Dyje mezi ústím Klaperova 

potoka a Rambachu 2,1 km ZJZ obce. 
3) Rýmařov, PR Pstruží potok, asi 4 km SZ od kostela. 

 
• Lokalita – jen na 99 znaků: Pokud je popis lokality delší než na 99 znaků, tak 

můžete zkracovat slova, ale jen tak, aby bylo pochopitelné o co jde. Pokud se vám to 
přesto nepodaří, tak celý popis lokality dejte do poznámky, ale současně ponechejte 
zkrácený popis v poli Locality. Na omezenou délku pole Locality si dejte pozor 
především v případě, že budete toto pole vyplňovat hromadně.  

 
 
B37–38) Longitude  a Latitude 

• Co vyplnit? Zadejte zeměpisnou délku (Longitude) a šířku (Latitude). 
• Musí se vyplnit? Ano. Toto pole je povinné. Souřadnice mohou chybět pouze u 

snímků převzatých z literatury, kde je lokalita zadána s malou přesností, nebo 
v případě, že máte podrobně popsané lokality – v tomto případě jsme schopni k Vašim 
snímků alespoň přibližné souřadnice dohledat.  

• Formát souřadnic: Souřadnice pište ve formátu DDMMSS (D=stupně, M=minuty, 
S=vteřiny). Např. souřadnici 14°23'56'' napište jako 142356, případně souřadnici 
14°23'56.25'' napište jako 142356.25. 

• Přesnost souřadnic: Zeměpisné souřadnice lze vyplňovat s přesností až na setiny 
sekund (např. 160310.65 = 16° 3´ 10,65" v. d., s přesností na desetiny a setiny sekund 
lze pracovat pouze při odečítání souřadnic z přístroje GPS s odpovídající přesností). V 
případě, kdy není možné určit zeměpisné souřadnice s přesností alespoň na desítky 
sekund (např. při přebírání údajů z literatury), měly by být místo souřadnic vyplněny, 
pokud je to možné, odkazy na čtverce středoevropského síťového mapování 5 x 3´ 
(např. 6062c) nebo alespoň 10 x 6´ (např. 6062) v poli CEBA_GRID. Pokud jsou 
dostatečně přesně zadány zeměpisné souřadnice, není třeba pole CEBA_GRID 
vyplňovat. 

• Přehození Longitude a Latitude: Zkontrolujte, jestli jste náhodou nepřehodili 
zeměpisnou délku (longitude) za šířku (latitude). 

• Kontrola souřadnic pomocí Google Earth: Zkontrolujte si prosím pomocí programu 
Google Earth, zda jste omylem nezadali špatnou souřadnici.  
Postup:  
Naistalujte si Google Earth => otevřete Turboveg: označte snímky, které chcete 
zkontrolovat => Export => Google Earth => nechte zatrženou volbu Immediately show 
distribution in Google Earth. 
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B39) Bias min 

• Co vyplnit? Pole udává přesnost určení zeměpisných souřadnic. Slouží při odečtu 
souřadnic z map a definuje možnou odchylku v minutách od koordinát uvedených v 
polích longitude a latitude. Např. údaj "21" v poli BIAS_MIN znamená, že chyba 
zeměpisné délky může být až 2 minuty na každou stranu od odhadnuté hodnoty udané 
v poli longitude a chyba zeměpisné šířky může být až 1 minuta na každou stranu od 
hodnoty v poli latitude. Bias znamená zkreslení a min je zkratka pro zeměpisné 
minuty.  

• Musí se vyplnit? Ano. Toto pole je povinné v případě, že souřadnice jsou zkreslené. 
• Odečítání souřadnic z mapy: Pokud souřadnice zjišťujete pomocí GPS přístroje, 

nebo pokud je lokalita snímku dobře popsaná (např. Habrůvka, 0,5 km SV od kostela), 
pak není potřeba bias_min vyplňovat. Pokud je ale lokalita snímku nepřesně popsaná 
(např. Plzeň nebo Křtiny, okolí obce), pak je potřeba bias_min vyplnit. Jak se zjistí 
bias_min je snadněji pochopitelné z následujícího obrázku. 
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Do políčka Bias_min se vyplňují 2 číslice. První z nich znamená zkreslení  zeměpisné 
délky v zeměpisných minutách, druhá pak zeměpisné šířky v zeměpisných minutách.  
Příklady: 
1) U lokality snímku je napsáno: „Mičovice, okolí obce“, ale už zde chybí v jakém směru 

a jak daleko od obce byl snímek umístěn. Snímek mohl být teoreticky umístěn 
v určitém okruhu (viz okruh). V tomto případě jako souřadnice snímku uvedete střed 
obce (viz bod A). Pak zjistíte souřadnice v bodě B a spočítáte vzdálenost bodu A od 
bodu B v minutách. Tento údaj pak zapíšete jako první číslici do Bias_min. Podobně 
určíte souřadnici bodu C a spočítáte vzdálenost bodu A od bodu C v zeměpisných 
minutách a tento údaj zapíšete jako druhou číslici do Bias_min. Je důležité, aby 
zkreslení zeměpisné délky bylo první a zkreslení zeměpisné šířky druhé v pořadí, 
protože pořadí musí být shodné s pořadím políček Longitude a Latitude 
v TURBOVEGu. 

2) Kostel v obci má souřadnici 49°20´00´´ a 14°50´11´´. Bod východně od kostela, ležící 
na východním obvodu oblasti, ve které byl snímek umístěn, má souřadnici 49°20´00´´ 
a 14°52´18´´. Jednoduše odečtete souřadnice zeměpisné délky druhého bodu (tedy 
východněji ležícího) od prvního (ležícího na místě kostela v obci), tj. 14°52´18´´ 
mínus 14°50´11´´ = 0°02´07´´. Pokud je vteřin víc než 30, tak minuty zaokrouhlíte 
nahoru. Jinak je zaokrouhlíte dolů. V tomto příkladě je zaokrouhlíte na 2 minuty. To 
samé uděláte pro zkreslení ve směru S-J, tedy pro rozdíl zeměpisných šířek. 

 
Pozn1. Oblast nemusí mít vždy kruhový tvar, ale může mít i protáhlý tvar, pokud se 
jedná např. o okolí vodního toku. V tomto případě může být zkreslení jen v jednom 
směru (v zeměpisné šířce nebo délce). 
Pozn2. Do TURBOVEGu nelze zapsat Bias_min ve formátu např. „01“, ale „zobrazí 
se jen „1“.  

 
B40) Bias_gps 

• Co vyplnit? Toto pole udává přesnost určení zeměpisných souřadnic. Do tohoto pole 
vypisujte přesnost měření udávanou přístrojem GPS v metrech. 

• Musí se vyplnit? Ano. Toto pole je povinné v případě, že souřadnice určujete pomocí 
přístroje GPS.  

 
B41) Ceba_grid 

• Co vyplnit? Zadejte odkazy na čtverce středoevropského síťového mapování 5 x 3´ 
(např. 6062c) nebo alespoň 10 x 6´ (např. 6062). 

• Musí se vyplnit? Ne. Toto pole je nepovinné. Je vhodné jej vyplnit především 
v případě, ne nemáte vyplněno pole longitude a latitude. Pokud jsou dostatečně přesně 
zadány zeměpisné souřadnice, není třeba toto pole vyplňovat. 

 
B42) Field_nr 

• Co vyplnit? Zadejte terénní číslo snímku, jak je máte uvedené v terénním deníku. 
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• Musí se vyplnit? Ne. Toto pole je nepovinné. Výhodou je, že údaje v tomto poli 
zůstávají v databázi stejné, bez ohledu na to, jaká čísla jsou přidělena snímkům 
v TURBOVEGu. 

 
B43) Habitat 

• Co vyplnit? Zadejte popis stanoviště (např. prudký svah s vystupujícími skalkami). 
• Musí se vyplnit? Ne. Toto pole je nepovinné. 
 

B44) Geology 
• Co vyplnit? Zadejte geologický podklad. 
• Musí se vyplnit? Ne. Toto pole je nepovinné 
 

B45) Soil 
• Co vyplnit? Zadejte půdní typ. 
• Musí se vyplnit? Ne. Toto pole je nepovinné. 

 
B46-50) Water_ph, S_ph_h2o, S_ph_kcl, S_ph_cacl2 a Soil_ph 

• Co vyplnit? Zadejte naměřené pH. 
Water_ph = pH vody (u vodní a mokřadní vegetace) 
S_ph_h2o = pH půdního výluhu ve vodě 
S_ph_kcl = pH půdního výluhu v roztoku KCl 
S_ph_calc2 = pH půdního výluhu v roztoku CaCl2
Soil_ph = pH půdního výluhu ve vodě, v roztoku KCl, nebo v roztoku CaCl2

• Musí se vyplnit? Ne. Tato pole jsou nepovinná. 
 
B51) Conduct 

• Co vyplnit? Zadejte naměřenou konduktivitu.  
• Musí se vyplnit? Ne. Toto pole je nepovinné. 

 
 
 
Automatická kontrola snímků: TURBOVEG CHECK-UP 
 

 
TURBOVEG CHECK-UP je speciálně upravená Microsoft Office Access databáze, která 
slouží ke kontrole fytocenologických snímků zapsaných do programu TURBOVEG. Její 
hlavní funkcí je vyhledávání chyb v druhových a hlavičkových datech. V druhových datech 
jsou to například překlepy ve jménech druhů nebo chybná vegetační patra, v hlavičkových 
datech např. chybějící údaje v povinných polích nebo chybné souřadnice. Aplikace se ovládá 
pomocí jednoduchého rozhraní, a je proto možné ji používat i bez znalosti práce s Microsoft 
Office Access. Chyby nebo údaje ve formě souhrnů se zobrazují jako přehledné sestavy, které 
lze vytisknout. TURBOVEG CHECK-UP používá pro hledání chyb tabulky, které je možné 
pravidelně aktualizovat z webových stránek Ústavu botaniky a zoologie. Kromě toho se 
v aplikaci nacházejí odkazy na důležité informace o České národní fytocenologické databázi. 
Je kompatibilní s databází TURBOVEG verze 2.88 a Microsoft Office 2000, 2003 a 2007.  
 
Verze pro Microsoft Office 2000-2003:  
http://www.sci.muni.cz/botany/vegsci/dbase/TURBOVEG_CHECK-UP_cz_2003.zip
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Verze pro Microsoft Office 2007: 
http://www.sci.muni.cz/botany/vegsci/dbase/TURBOVEG_CHECK-UP_cz_2007.zip
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